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Overview 

Stellar MBOX to PST Converter converts mailbox from Thunderbird, Spicebird, Entourage, Pocomail, 

Eudora, AppleMail, Mulberry, SeaMonkey, Netscape, ClawsMail, OperaMail, MozillaMail, Evolution, 

Sylpheed, Cone, Mutt, and Gnu Mail files to Outlook mailbox (PST files). You can see the preview of 

converted mails after successful completion of conversion process. 

 

The software gives option to save the converted mails to a new or existing Outlook PST file. 

Key Features of Stellar MBOX to PST Converter 

• User friendly and secure software. 

• Converts Thunderbird files to Outlook PST files. 

• Converts Cone to Outlook PST files. 

• Converts Mutt files to Outlook PST files. 

• Converts Gnu Mail files to Outlook PST files. 

• Converts Spicebird files to Outlook PST files. 

• Converts Entourage files to Outlook PST files. 

• Converts Pocomail files to Outlook PST files. 

• Converts Eudora files to Outlook PST files. 

• Converts AppleMail files to Outlook PST files. 

• Converts Mulberry files to Outlook PST files. 

• Converts SeaMonkey files to Outlook PST files. 

• Converts Netscape files to Outlook PST files. 

• Converts ClawsMail files to Outlook PST files. 

• Converts OperaMail files to Outlook PST files. 

• Converts MozillaMail files to Outlook PST files. 

• Converts Evolution files to Outlook PST files. 

• Converts Sylpheed files to Outlook PST files. 

• Provides preview of mails. 

• Log Report. 
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Installation Procedure 
Before installing the software, check that your system meets the minimum system requirements: 

Minimum System Requirements 

• Processor: Pentium Class 

• Operating   System: Windows 8/  Windows 7 / Windows Vista / Windows 2003-2008 Server / 

Windows XP  

• Microsoft Office: 2010, 2007, 2003 

• Memory: Minimum 1 GB 

• Hard Disk: 50 MB of Free Space 

To install the software, follow these steps: 

• Double-click StellarMBOXtoPSTConverter.exe executable file to start installation. Setup - 

Stellar MBOX to PST Converter dialog box is displayed.  

• Click Next. License Agreement dialog box is displayed. 

• Choose I accept the agreement option. Next button will be enabled. Click Next. Select 

Destination Location dialog box is displayed. 

• Click Browse to select the destination path where the setup files will be stored. Click Next. 

Select Start Menu Folder dialog box is displayed. 

• Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks 

dialog box is displayed. 

• Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.  

• Review the entries. Click Back if you want to change them. Click Install to start installation. The 

Installing window shows the installation process. 

• After completing the process, Completing the Stellar MBOX to PST Converter Setup Wizard 

window is displayed. Click Finish. 

 

Note: Clear Launch Stellar MBOX to PST Converter check box before clicking Finish to prevent the 

software from launching. 
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Launching the Software 
You can use any of the following methods to start Stellar MBOX to PST Converter:  

• Click Start -> Programs -> Stellar MBOX to PST Converter -> Stellar MBOX to PST 

Converter.  

• Double click icon on the Desktop.  

• Click Stellar MBOX to PST Converter icon in Quick launch.  
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User Interface 

Stellar MBOX to PST Converter software has a very easy to use Graphical User Interface. The user 

interface contains features required for conversion. 

 

After launching the program, you will see the main user interface as shown below: 

 

 
 

The user interface contains menus and buttons that lets you access various features of the software with 

ease.  
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Menus 

File 

Select Mail Client 
Use this option to open Select Mail Client to be 
Converted to Outlook PST dialog box. 
 
Convert to PST 
Use this option to start the conversion process. 
 
Exit 
Use this option to exit the application. 

 
 

File Menu 

View 

Log Report 

Use this option to view and save log report 

 
 

View Menu 

Activation 

Activate Stellar MBOX to PST Converter 

Use this option to activate the product. 

 
 

Activation Menu 

 
Help 
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Stellar MBOX to PST Converter 
Help 

Use this option to see user help 

guide. 

 

Purchase Stellar MBOX to PST 

Converter 

Use this option to buy Stellar 

MBOX to PST Converter. 

 

View Support Section 

Use this option to visit support page 

of stellarinfo.com. 

 

View Knowledge Base  

Use this option to visit 

knowledgebase articles of 

stellarinfo.com. 

 

Submit Enquiry 

Use this option to submit enquiry to 

stellarinfo.com. 

   

About Stellar MBOX to PST 
Converter 

Use this option to read information 

about the software 

. 

  

 
Help Menu 

http://www.stellarinfo.com/email-tools/mbox-to-pst-converter/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
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Buttons 

 

 
Select Mail Client  

 

 

 
Click this button to open Select Mail Client to be Converted to Outlook 
PST dialog box. 

 

 
Convert to PST  

 

 

 

Click this button to start the conversion process.   

 

 
Help 

 

 

 

Click this button to access the User Guide.  

 

 
Update Wizard  

 

 

 

Click this button to check for both, latest minor and major version available 

online.  

 

 
Purchase 

 

 

 

Click this button to purchase the software.  

 

 
About 

 

 

 

Click this button to know about the software.  
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Ordering the Software 

To purchase the software online, please visit http://www.stellarinfo.com/email-tools/mbox-to-pst-

converter/buy-now.php and place an order. 

Alternatively, click Purchase button on the application tool bar to purchase the software online.  

Select any of the methods given above to go further with the purchasing process. 

Once the order is confirmed, a serial number will be sent through e-mail, which would be required to 

activate the software. 

http://www.stellarinfo.com/email-tools/mbox-to-pst-converter/buy-now.php
http://www.stellarinfo.com/email-tools/mbox-to-pst-converter/buy-now.php
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Registering the Software 

The demo version of Stellar MBOX to PST Converter can be downloaded from the Stellar web site. This 

demo version is just for evaluation purpose and must be eventually registered to use the full functionality 

of the software. Software can be registered after receiving the key. To register the demo application, 

follow these steps: 

 

• Start the demo version of the application.  

• Select Activate Stellar MBOX to PST Converter option in Activation menu. Activation dialog 

box is displayed. 

• Enter the user name and activation code, received by mail, after purchasing the software. 

• A confirmation message is displayed if a valid code is entered.  

• Click OK. 

 

Note: In demo version of the software, you will be able to see the mail body but cannot open 

attachments. To view / save all data and open attachments, you need to purchase and register the 

software. 
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Updating the Software 

There are periodical software updates for Stellar MBOX to PST Converter. The software updates should 

be done to keep the software up-to-date. The updates can be a newly added functionality, a new feature, 

a new service, or any other information that can be important for improvement. Update option in the 

application is capable of checking for the latest updates. This will check for both latest minor and major 

version available online. You can easily download minor version through the update wizard. However, the 

major version, if available, has to be purchased. While updating the software, it’s recommended to close 

all the running programs. Note that demo version can not be updated.  

To update the application, follow these steps: 

• Click on Update Wizard button in application tool bar. Update Wizard is displayed. 

• Click Next. A busy timer shows that updates are being searched. If any new version is found, a 

message indicates its availability.  

• If a message is displayed that no updates are available, Click Cancel to close the wizard. 

• Click Next. The software will start downloading the update files from the server. When the 

process is complete, the software will upgrade to the latest version.  
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Uninstalling the Software 

You can use any of the following options to uninstall Stellar MBOX to PST converter:  

• Click Start -> All Programs -> Stellar MBOX to PST Converter -> Uninstall Stellar 

MBOX to PST Converter. Follow on screen instructions to completely remove the 

software, including registry entries from your computer. Or, 

 

• Click Start -> Control Panel -> Add Or remove Program. Select Stellar MBOX to PST 
Converter entry from the displayed list and click Change/Remove. Follow on screen 

instructions to completely remove the software as well as registry entries from your 

computer. 
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Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products.  

You can either call us or go online to our support section at http://stellarinfo.com/support/. 

For price details and to place the order, click https://www.regnow.com/checkout/cart/add/5388-58. 

Chat Live with an Online technician at http://stellarinfo.com/support/. 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/. 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php. 

E-mail to Stellar Support at support@stellarinfo.com. 

 

 

 

 

 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 
USA (Tollfree- Pre Sales Queries)USA 

(Post Sales Queries) 
UK (Europe) 

Australia & Asia Pacific 
Netherlands Pre & Post Sales Support 

Worldwide 
Skype Id 

Email Orders  

+1-877-778-6087 
+1-732-584-2700 
+44-203-026-5337 
+61-280-149-899 
+31-208-111-188 
+91-124-432-6777 
stellarsupport 
orders@stellarinfo.com  

http://www.stellarinfo.com/support/
https://www.regnow.com/checkout/cart/add/5388-58
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com.
mailto:orders@stellarinfo.com
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Select File(s)/Identity 
To select MBOX file / Identity of your preference: 

• Launch Stellar MBOX to PST Converter. Select Mail Client to be Converted to Outlook PST 

dialog box is displayed as shown below: 

 

 
 

• Click on the desired Mail Client icon. 

•  Select File/Folder dialog box opens as shown below:  

 

 

 

• Click Select File/Select Identity Folder button and locate file/Identity. 

• Selected file/Identity path is displayed in Select File/Folder Path text box. 

• Click Convert button to start the conversion process. 
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Note: You can only select a complete Identity folder for the following mail clients: Apple Mail, ClawsMail, 

MozillaMail, OperaMail, Sylpheed.  
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Find Files 

You can search for MBOX, MBX, MacMBOX, and AppleMail files using Find File Option in Select 

File/Folder dialog box. You can search for files in drives, folders and sub folders. However, you can select 

only one drive at a time to search for files. 

To search for MBOX, MBX, MacMBOX, and AppleMail files: 

• Click Find File Option in Select File/Folder dialog box. 

• Browse for Folder dialog box opens. 

• Select the required drive/folder/sub folder and click OK to search for files.  

• After the search is finished, list of MBOX/MBX/MacMBOX/AppleMail files found in the selected 

drive/folder/sub folder is shown in Select files dialog box as shown below: 

 

 

 

• Select files you wish to convert from this list and then click Convert to start the conversion process.  
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Preview of Mails 

You can see the preview of converted mails after successful completion of conversion process. Left pane 

displays selected MBOX filename under Root node in a tree like structure. Upper right pane displays the 

list of converted mails. To see content of desired mail, click on it in upper right pane. The content is 

displayed in lower right pane as shown below. 
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Save Converted Mails 
To save converted mails: 

• Click Convert to PST button on the toolbar or select Convert to PST option in the File menu. 

• Save File dialog box opens as shown below. 

 

 
 

• To save converted mails into a new PST file: 

• Select Save as new Outlook PST File and click Browse.  

• Browse For Folder dialog box opens. Select location for saving PST file and click 

OK. 

• The converted mails will be saved into a new PST file at the specified location. 

 

• To save converted mails into an existing PST file: 

• Select Append data into existing profile/PST file. Select Profile and PST dialog 

box appears as shown below: 
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• To add the converted mails to an existing Outlook profile, choose Select Outlook 

Profile to add converted mails and select one of the profiles that appear in the 

list. Click OK. 

Or,  

To add the converted mails to an existing Outlook PST file, choose Select Outlook 

PST file to add converted mails and then click Browse to select the PST File. Click 

OK.  

• The converted mails will be saved into the selected Outlook Profile / Outlook PST 

file. 
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Import PST files in MS Outlook 

To import PST files in Microsoft Outlook 2010:  

• Open Microsoft Outlook. In the File Menu, select Open -> Import. 

• In the Import and Export Wizard, select Import from another program or file, click Next. 

• In the Import a File dialog box, select Outlook Data File (.pst), click Next.  

• Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

• In the Import Outlook Data File dialog box, select the folders that should be imported in 

Microsoft Outlook. Click Finish. 

To import PST files in Microsoft Outlook 2007 / 2003: 

• Open Microsoft Outlook. In the File menu, select Import and Export. 

• In the Import and Export Wizard, select Import from another program or file, click Next. 

• In the Import a File dialog box, select Personal Folder File (PST), click Next. 

• Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

• In the Import Personal Folders dialog box, select the folders that should be imported in 

Microsoft Outlook. Click Finish.  
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View and save Log Report  

During and after completion of the conversion process, you can see log details in bottom window of 

Stellar MBOX to PST Converter. The Log Report window displays beginning of the process, end of the 

process, name of the file etc. during running of the process. With Stellar DBX To PST Converter, you can 

save Log Report to analyze recovery process at a later stage. 

   
• To view log details, click Log Report in View menu on the menu bar. Log Report window opens 

as given below. 

 

 
 

• Click Save Log button to save log report. Enter file name and choose destination in Save As 

dialog box.  

 

• Click Clear Log button to clear Log Report. 

 

• Click Close button to close Log Report. 
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Legal Notices 

Copyright 

Stellar MBOX to PST Converter software, accompanied user manual and documentation are copyright of 

Stellar Information Systems Ltd., with all rights reserved. Under the copyright laws, this user manual 

cannot be reproduced in any form without the prior written permission of Stellar Information Systems Ltd. 

No Patent Liability is assumed, however, with respect to the use of the information contained herein. 

Copyright © Stellar Information Systems Ltd. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

 

STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD TO THIS 

MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY EXPRESSLY 

DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY 

PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR INFORMATION 

SYSTEMS LTD ASSUMES NO LIABILITY FOR ANY DAMAGES INCURRED DIRECTLY OR 

INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR OMISSIONS 

CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE MANUAL. IN 

NO EVENT SHALL STELLAR INFORMATION SYSTEMS LTD, BE LIABLE FOR ANY INCIDENTAL, 

CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER BASED ON TORT, 

CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION WITH THIS MANUAL OR ANY 

OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. 

Trademarks 

Stellar MBOX to PST Converter® is a registered trademark of Stellar Information Systems Ltd. 

Windows 2000 Server®, Windows XP®, Windows 2003®, Windows Vista®, Windows 7®, Windows 8® 
are registered trademarks of Microsoft® Corporation Inc. 
All Trademarks Acknowledged. 
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All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

License Agreement 

Stellar MBOX to PST Converter 

Copyright © Stellar Information Systems Ltd. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar MBOX to PST Converter. 

 

Your Agreement to this License 
 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Systems Ltd. 

 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar MBOX to PST Converter with which this License is included, you may return the 

complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar MBOX to PST Converter. For purposes of this License, if you have a valid single-user license, you 

have the right to use a single Licensed Copy of Stellar MBOX to PST Converter. If you or your 

organization has a valid multi-user license, then you or your organization has the right to use up to a 

number of Licensed Copies of Stellar MBOX to PST Converter equal to the number of copies indicated in 

the documents issued by Stellar when granting the license. 

 

Scope of License 

 

Each Licensed Copy of Stellar MBOX to PST Converter may either be used by a single person or used 

non-simultaneously by multiple people who use the software personally installed on a single workstation. 

This is not a concurrent use license. 

 

http://www.stellarinfo.com/
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All rights of any kind in Stellar MBOX to PST Converter, which are not expressly granted in this license, 

are entirely and exclusively reserved to and by Stellar Information Systems Ltd. You may not rent, lease, 

modify, translate, reverse engineer, decompile, disassemble or create derivative works based on Stellar 

MBOX to PST Converter nor permit anyone else to do so. You may not make access to Stellar MBOX to 

PST Converter available to others in connection with a service bureau, application service provider or 

similar business nor permit anyone else to do so. 

 

Warranty Disclaimers and Liability Limitations 

 

Stellar MBOX to PST Converter and all accompanying software, files, data and materials are distributed 

and provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge 

that good data processing procedure dictates that any program including Stellar MBOX to PST Converter 

must be thoroughly tested with non-critical data before there is any reliance on it and you hereby assume 

the entire risk of all use of the copies of Stellar MBOX to PST Converter covered by this License. This 

disclaimer of warranty constitutes an essential part of this License. In addition, in no event does Stellar 

authorize you or anyone else to use Stellar MBOX to PST Converter in applications or systems where its 

failure to perform can reasonably be expected to result in a significant physical injury or in loss of life. Any 

such use is entirely at your own risk and you agree to hold Stellar harmless from any and all claims or 

losses relating to such unauthorized use. 

 

In no event shall Stellar Information Systems Limited or its suppliers be liable for any special, incidental, 

indirect, or consequential damages whatsoever (including, without limitation, damages for loss of 

business profits, business interruption, loss of business information, or any other pecuniary loss) arising 

out of the use of or inability to use the software product or the provision of or failure to provide support 

services, even if Stellar Information Systems Limited has been advised of the possibility of such 

damages. In any case, Stellar Information Systems Limited’s entire liability under any provision shall be 

limited to the amount actually paid by you for the software product. 

 

General 
 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 
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violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

 

Copyright © Stellar Information Systems Ltd. All rights reserved. 
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FAQs 
1. What does the demo version of the software do? 

In demo version of the software, you will be able to see the mail body but cannot open 

attachments. To view / save all data and open attachments, you need to purchase and register the 

software. 

 

2. What is MBOX file format? 

The MBOX file is the most common format for storing email messages on a hard drive. All the 

messages for each mailbox are stored as a single, long, text file in a string of concatenated e-mail 

messages, starting with the From header of the message. 

   
An MBOX is a text file containing an arbitrary number of e-mail messages. Each message consists 

of a postmark, followed by an e-mail message formatted according to RFC 822. The file format is 

line-oriented. Lines are separated by line feed characters (ASCII 10). A postmark line consists of 

the four characters From, followed by a space character, followed by the message's envelope 

sender address, followed by white space, and followed by a time stamp. The sender address is 

expected to be an addrspec as defined in appendix D of RFC 822. 

The date is expected to be formatted according to the syntax represented in the augmented 

Backus-Naur formalism used by RFC 822. 

 

3. Which email clients are supported by Stellar MBOX to PST Converter?  

Stellar MBOX to PST Converter supports Thunderbird, Spicebird, Entourage, Pocomail, Eudora, 

AppleMail,  Mulberry, SeaMonkey, Netscape, ClawsMail, OperaMail, MozillaMail, Evolution, and 

Sylpheed files. 

 

4. Can I convert a single mail into PST file? 

You can only convert a complete MBOX file.  

 

5. If the location of MBOX files are not known, can I search for then using Stellar MBOX to 
PST Converter? 

Yes, Find File option of the software lets you search for MBOX files in specified drive of the 

computer. To know how to use this option, please refer Find Files topic of help manual. 

 

6. Can I convert multiple MBOX files simultaneously? 

Yes. 
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7. I want to save converted mails into an existing PST file. How can I do it? Stellar MBOX to 

PST Converter gives you option to save converted mails into an existing or new PST file. For full 

details, please refer Save Converted Mails topic of this help manual. 
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About Stellar 

Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data Protection 

Software for more than a decade.  

 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

Product line:  

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

For more information about us, please visit www.stellarinfo.com 

 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/file-eraser.htm
http://www.stellarinfo.com/
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